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Overview 
This note describes the recommended procedure for a Room Admin to migrate room calendar data by 

exporting data from Meeting Maker and importing into FermiMail. The major steps are: 

1. Export the Old Calendar: Export the old calendar from Meeting Maker. 

2. Convert the Old Calendar: Convert the old calendar to a format that FermiMail can interpret. 

3. Import the Converted Calendar: Import one Event at a time via form, allowing simple changes. 

4. Complete the Converted Calendar: Add data that does not migrate to Events. 

Requirements 
 This procedure requires the use of the windows Meeting Maker client and Outlook 2010. It also 

requires the use of a supported web browser to access the calendar converter. 

 This procedure requires Full Access to the FermiMail room calendar account in question. 

 Room calendar accounts require a migration-specific configuration setup in FermiMail. 
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 This procedure does NOT require a FermiMail calendar to be empty before executing. Migrated 

events will be added to existing events. However, it is less risky to migrate into an empty 

calendar since deleting all events quietly is an option for recovery. 

Known Issues 
 If you are migrating a smaller number of events from MM to FermiMail, perhaps fewer than 20 

to 30 events, then we recommend that you simply recreate those events manually in FermiMail 

instead of using this procedure. This reduces the technical risk and invests your time in learning 

a tool you will use in the future. Learning this procedure will have no value once it is completed, 

and there is chance that MM will not export your calendar (silent failure) or that you will import 

your events into a secondary calendar (pilot error). 

 The following features are NOT exported by Meeting Maker, and thus are not treated in this 

procedure. They must be migrated or setup manually in FermiMail: 

o To Do items 

o Banners (multi-day all-day events) 

o MM Options – Private, Reminder, Reminder Interval, Flexible, Labels 

o User Interface configuration data – working hours, label values, proxy/delegate settings  
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A. Export the Old Calendar 

1. Open the Meeting Maker windows application.   

 

2. Login as yourself. 

 

a. (Migration Service only) To proxy as the User whose calendar is to be exported: select 

Proxy in the menu, and then More Proxies… 

 

 

b. (Migration Service only) Then select the user to be migrated. Click Open >>>, and OK. 

 

 

3. Select the calendar you wish to export in Meeting Maker. This is more obvious if you have that 

calendar open, rather than minimized, in the Meeting Maker window. 
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4. We recommend exporting TWO old calendars for each room. (Meeting rooms in Meeting Maker 

have no event information before 1/1/2006): 

a. Recents: 1/1/2012 into the future – import 1 events at a time with invitations sent out 

b. Ancients: 1/1/2006 (or earlier) to 12/31/2011 – import all at once with no invitations 

 

5. Select the File menu, then select Export as ICalendar by Date… 

 
 

6. Set the From and To dates to capture as much or as little of your calendar as you want to 

migrate. This selects all Events that fall within this time window. If a recurring meeting has at 

least one occurrence in this time window, then all recurrences of the meeting are shown even 

those outside this time window. 
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7. Be sure that Export single file is checked. 

 

8. Select OK. MM may take a LONG time to generate a calendar file to save. We have observed 5-

10 minutes delay for some dense user calendars, during which the Meeting Maker window may 

appear to freeze. If this takes longer than 15 minutes, then you may have a corrupt Meeting 

Maker calendar event. 

a. Suspect Event in Meeting Maker Calendar: Set the From date closer to current date and 

retry. Step the From date closer to the current date and retry until you get an export file 

within a tolerable time. You may be able to identify the suspect event by process of 

elimination, comparing the list of exported events to the MM calendar content. 

 

9. Select a location and filename to save the file, then click Save. 

a. For this document, we assume the saved file is called MMCalendar-File1.ics 

 

10. If you are exporting two old calendars, repeat steps 5 – 9 with different From and To dates.  
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B. Convert the Old Calendar 
1. Open the FermiMail Room Calendar Converter application suited to your goal. 

a. Room Migration Converter:  http://jabber3.fnal.gov/cgi-bin/calendartool?Room  

Note the uppercase ‘R’ in Room. You should see exactly the following before 

proceeding: 

 

 
 

2. Select Browse to select the calendar file to be converted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://jabber3.fnal.gov/cgi-bin/calendartool?Room
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3. Input the New Room Name using the room selector: 

 

 

4. MIGRATOR Choice: 

a. If you are migrating a Room calendar, then select One event per file zip archive, OR 

b. If you want to produce a compact Event listing, then select Event list spreadsheet. The 

listing is of Events that would be output by the converter, so some filtering or 

translation may be applied. This listing can be used to drive a manual re-entry of Events 

or just to count the number of Events in the calendar file. 

 

5. Select Convert Calendar 
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6. If you experience a converter error dump (the purple screen shown below), then please copy 

the text shown and email it to exchange-proj@fnal.gov for timely resolution. You will not be 

able to proceed until this error is resolved. 

 
 

7. Select location to save the converted calendar file or event listing spreadsheet, click OK. 

a. For this document, we assume the saved zip archive file is called converted-Folder2.zip  

mailto:exchange-proj@fnal.gov
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C. Import the Converted Calendar 
1. Extract and open the zip archive converted-Folder2.zip containing the calendar event files. 

a. Right-click on converted-Folder2.zip and select Extract All… 

b. Open the resulting folder converted-Folder2 

2. Open and login to Outlook 2010 on Windows 

a. (Migration Service only) Select an Outlook profile granting access to the user’s mailbox. 

If you do not see this profile selection box below, then STOP and ask for help. This 

procedure MUST be performed in the correct permissions state to avoid adding events 

to the migrator’s own calendar. The example shows a default profile (for the migrator’s 

own use) and two people whose calendars are going to be migrated. 

 

b. (Migration Service only) Authenticate using your own SERVICES username and 

password. 

c. We recommend that you disable spell-checking in Outlook. Frankly we have not figured 

out to do this yet for calendar events. We will adjust this step when we get it disabled. 

3. Disable cached-Exchange mode in Outlook 2010 

a. Go to File, and Account Settings 

b. Select the account settings you are using. In the example below, select cstestroom. 
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c. Uncheck Use Cached Exchange Mode 

 

d. Click Next, Finish, and Close. 

e. Restart Outlook (using this same profile if migrating someone else). 

f. You now can be assured that what you see in Outlook reflects what is stored on the 

server. This is critical if you are migrating a large number of events. Without this, the 

events may seem to have migrated in a few minutes, but are only in local cache which 

may take 30 minutes plus for the cache to sync to the FermiMail server. If you 

disconnected before then, many events would never get to the server. NOW, when you 

see the migration completed on your client, it is really uploaded to the server. You may 

undo this setting AFTER the migration is completed.  
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For each file in the folder, do the following: 

4. Open the individual calendar file (EVENT###.ICS) by double-clicking on it, or by: 

a. Select the File tab, Open, and then Open Calendar: 

 

b. Select the file Converted-File2.ics 

c. Select OK. 

d. The “Send Update” GUI form will open pre-populated with this one event’s data. 

e. ERROR: If you experience a “Not a Calendar file” error when opening the file, then you 

will have to enter that event manually in the FermiMail calendar. See step D.3. 
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5. Visually inspect the Event in the Send Update GUI form. Make obvious corrections to the data. 

Please leave the [MM Converter] tag in the Description field. 

a. If all went well, then you should see something like this. You see that there the room is 

listed in the To… field and in the Location field. There is no Organizer field showing. 

 

b. Sometime, a converted meeting invitation has nothing in the To… field. If this is the 

case, use the Room Finder (Rooms…) to add the room to the To… list. This will also set 

the Location field. 

 

 

 

 

To… 

Location 

Room 

Finder 



13 
 

c. If the Room name selected was incorrect for some reason, or you lack privileges to 

migrate a room calendar (is the Migrator profile in use?), then you will see the Organizer 

field. This is an error and you should ask for help at this point. Please do not proceed if 

this happens. 

 

 

6. Select Send Update to import the Event into FermiMail. 

a. If all has gone Meeting invites are automatically (re-) issued by Exchange to ATTENDEEs. 

 

6.  Import all of the EVENT files in converted-Folder2 before proceeding.  

Send 

Update 

Organizer 

shows = 

BAD 
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D. Complete the Converted Calendar 
1. Add Event information that does not export from Meeting Maker: MM Options 

a. MM Options: Private, Reminder, Reminder Interval, Flexible, Labels 

b. Review Events in Meeting Maker that may require one or more of the “Meeting Maker 

Options” to be re-applied in the FermiMail Event. Then manually set that option. 

c. Select a Meeting Maker Event, and select its Options tab. 

 
 

 

 

 

Meeting 

Maker Event: 

Details Tab 

Meeting Maker 

Event: Options Tab 

 Reminder 

 Reminder Interval 

 Private 

 Flexible 

 Label(s) 
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d. Private: Private setting is visible in each Event in the calendar as well as on the Options 

tab of each MM Event. 

i. Identify Events that should be marked private, either from personal knowledge 

or by scanning the Meeting Maker calendar for key symbols in the event boxes. 

 

 

 

 

 

Private Event: Key symbol 

on left side 



16 
 

 

ii. Set Private on the Converted Event by right-clicking on the Event and selecting 

Private. When you view the Event details, you will see the padlock symbol 

highlighted. 

 

 

 

 

Set Private 

Private: Padlock 

highlighted 
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e. Reminder, Reminder Interval: Reminder settings are only visible on the Options tab of 

each Event in MM.  

i. Identify Events that should be marked private, either from personal knowledge 

or by scanning the Meeting Maker calendar for key symbols in the event boxes. 

 

 
 

ii. Set Reminder and Reminder Interval settings using the interval selector. 

 

 
 

 

 

 

 

 

 

Reminder Interval Selector: 

Note Bell symbol 
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iii. Then click Send Update to update the Reminder settings. 

 

iv. If you receive an error saying that there is no one to send this to, you should put 

the Room in the To… list. Try using the Room Finder (Rooms…) 

v. If you receive more warnings, then please click through these to send the 

update. We are updating a calendar “offline”, which Outlook is not accustomed 

to doing, so Outlook will treat some of our actions likely to be user errors. 

f. Flexible: Flexible setting is only visible on the Options tab of each Event in MM. We have 

not been able to determine a direct translation for MM Flexible in FermiMail. 

g. Labels: Labels are only visible on the Options tab of each Event in MM. Labels can be 

implemented by FermiMail Categories and/or Importance settings. Since labels have 

been applied by different users for different grouping or labeling purposes, we defer to 

users to apply these features as they see fit to accomplish their goals. If you select 

Categorize and then All Categories, you should be able to customize the Categories to 

implement whatever custom Labels you may have used in Meeting Maker. 

          

Send 

Update 
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2. Add Event information that does not export from Meeting Maker:  Banners 

a. Identify Banners in Meeting Maker that you wish to retain. 

 

b. Select Home, Week view (in Arrange group). Select-drag your cursor across the days you 

wish to create the Banner for and type in the title. 

 

3. Manually re-create EVENTS reported to use unsupported recurrence patterns. 

a. For any Events reported by the Converted as having an unsupported recurrence pattern, 

you will have to manually create these events in FermiMail. This was very rare in testing 

across many calendars, but technically can happen. Please see Recreating Unsupported 

Recurrence procedure for guidance. 

 

4. Visually inspect their FermiMail calendar against their MM calendar 

a. Remove obviously duplicated Events. 

i. We expect that there will be some duplicates for Users who booked their own 

meeting in a scheduled Room. In this case, the User is expected to contact the 

Room Admin to discuss which meeting notice will be deleted or remain. 

b. Look for Events that are missing. There should be none in a Room calendar migration. 

 

5. Your Room calendar migration is complete.  

A Banner in Meeting Maker 
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Checks 
If the Room had no events in it before migration, then you can cross-check the number of Events 

reported by the Converter (Step B.4, select event listing) against the number of events reported by 

Outlook in the List view of the calendar. We have observed: 

 Excess events in Outlook list – migrator accidentally entered an event twice. Order the events by 

Subject in the list view. Look for identical Subject and Times. Open the identical events to be 

sure they have the same description and other fields. If so, you can silently remove the duplicate 

event. Note that this can happen quite easily since events seem to open up a second invitation 

about 5-10% of the time. You have to look out for these. 

 Too few events in Outlook list – one of the event files that were migrated may have experienced 

a “not a calendar file” error that went unnoticed by the migrator. This is awkward to fix 

afterwards since you have to search through the Converter event listing to look for an entry that 

does NOT show up in the Outlook list. We recommend that you migrate the missing event 

manually at this point. 

End Results 
 The content of the Meeting Maker calendar has now been imported into FermiMail. You may 

begin to maintain these Events in FermiMail going forward. 

 You may want to re-enable spell checking in Outlook, if you disabled it. 

 You may want to re-enable cached Exchange mode if you had it set before. 

 

 Please be sure to report that this room calendar has been completed so that the FermiMail 

Admin can restore the ROOM account configuration to its normal operations state. 


